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1. Overview 

1.1 System Definition 

XPT (Extended Pseudo Trunk) is a new distributed trunking system solution developed solely by Hytera, 

which is further developed based on self-developed Pseudo Trunk technology by Hytera and combined 

with advantages of digital trunking system. XPT system has three main advantages: No Central 

Controller, low cost of platform building and load balance. 

1.2 System Background 

Digital conventional communication system combines the advantages of two-way radio communication 

and digital technology, and also has many strengths and functions of analog system. But in conventional 

communication system, the channel resource utilization is restricted due to one channel only support two 

call at a time at most. Thus, multiple radios communication is restricted in digital conventional 

communication system. Digital trunking system has larger coverage, stronger noise cancelling capability 

and its channel resource can be allocated automatically. But the platform building of trunking system is 

complex and it is inconvenient to upgrade the conventional system to trunking system. Moreover, 

trunking system will require a large amount of equipments and cost to support.  

XPT system is an economical and practical digital upgrading solution, which can build an extended 

pseudo trunking system using multiple repeaters. It is suitable for professional customer whose digital 

key business is based on digital conventional communication system. XPT system has the scale and 

efficiency of trunking technology, clearer voice quality, and extended communication capacity realized 

by sharing the logic channel resource of the repeater. It can support high density voice and data 

communication of more people using only one single base station.  

1.3 Operating Principle 

XPT system can integrate multiple repeaters which are operating under digital repeating mode in the 

same zone to build a XPT site. By sharing the logic channels in the site, the radios can communicate via 

all the repeaters in the site without specific control channels, so as to increase the channel utilization.  

In XPT system, the calls are always initiated in the home repeater of the radio first. When the repeater 

which the radio belongs to (Home Repeater) is busy, the radio will initiate voice or data service in other 

free repeaters (Free Repeater). In this way, the system access time will be shortened and 

communication capacity can be extended at a max level while guaranteeing the service quality. 
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Moreover, there is little chance that the logic channels will be occupied at the same time. Thus, the call 

rejection chance in XPT system is far less than in conventional system. This can help the customers to 

conduct voice and data communication swiftly and efficiently in a same system.  

1.3.1 XPT Trunking Protocol 

 

 

 Home Repeater 

All radios have one of the site repeaters assigned as its "home repeater “. For example, we allocate 

home repeater R1 for G1,G2,G3.  

When the Home Repeater is idle, the radio will keep monitoring its Home Repeater, and determine 

whether there is incoming call in XPT system according to the broadcast signal of Home Repeater. 

When there is idle slot in Home Repeater, the radio will always initiate calls in its Home Repeater 

first.  

 Home Group 

In one XPT site, one repeater can assign one or more home groups and specify the radio user group 

under the repeater. One user group can be the home group of one repeater only, and the home group 

of different repeaters in one XPT site must be unique. For example, G1, G2 and G3 have already 

been set as the home group of Repeater R1, they cannot be set as the home group of other 

repeaters.  

 When an idle repeater receives a group call, the repeater will determine whether the group call 

belongs to the home group of the repeater in the site. If the group call belongs to the home group 
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of this repeater, the repeater will inform other repeaters of its updated status (repeating a group 

call), and broadcast signals to inform the monitoring radio, so as to allow the home group 

members to receive the group call. If the radio initiates a group call request which is not within the 

site (does not belong to the home group of the repeater in the site), the repeater will reject the 

request, and the radio will not be able to initiate the group call.  

 When an idle repeater receives group call repeating message from other repeaters, the repeater 

will determine whether the group call belongs to the home group of the repeater. If the group call 

belongs to the home group of the repeater, the repeater will broadcast signals to inform the 

monitoring radio, so as to allow the home group members to switch to the repeating repeater to 

receive the group call.  

 Free Repeater 

When the home repeater of the radio is busy, the radio will switch to monitor the free repeater and 

initiate calls in the free slot of the free repeater. For example, G1 and G2 calls are ongoing on slot1 

and slot2 of R1. The Group members of G3 will switch to free repeater R3 to monitor and transmit 

call.  

One free repeater should be specified in each XPT site at any moment, unless all the repeaters in the 

site are occupied. In each LAN site, any registered and idle repeater can be specified as free 

repeater of the site. Only one free repeater can be specified at a time for each LAN site.  
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1.3.2 Home Repeater Allocation 

 

 

 Radios must to be programmed to be homed to be a specific repeater under the site.  

 All sites will also need the radios to be allocated its home repeater. Doing this will ensure that the 

radios can operate with the best System Access Timing performance.  

 A group that is not configured to be in any of the sites is not allowed to transmit in the system.  
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1.3.3 Free Repeater Assignment 

 

 

 Only one free repeater for each site at the same time. 

 Any successful registration state is sleep or idle repeaters are eligible to be elected as the free 

repeater of site.  

 When free repeater is busy，the current free repeater will assign new free repeater from idle repeater 

list before it switch to traffic repeater. 

 

1.4 Typical Network Topological Structure 

The Typical Network Topological Structure of XPT system consists of radios, repeaters, Ethernet switch, 

router, IPPBX, third-party application, RDAC and telephone network. The radio makes call to other 

communication devices via the repeater; the repeaters connects to each other via switch; XPT site 

connects to WAN, third-party application and RDAC via router; XPT system connects to telephone 

network via IPPBX. See the figure below.  
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Figure 1–1 Network Structure of XPT System 

XPT system includes Single-site Trunking System and IP Multi-site Interconnect Trunking System. The 

XPT single-site system consists of one master repeater and multiple slave repeaters. When configuring 

XPT single site system, the radios will be allocated with specific frequency and slot in advance. An idle 

radio always monitors its idle home repeater. The home repeater will broadcast the XPT system status 

information in each frequency via beacon signal, so as to inform the radio of available channel resource. 

In such case, the radio can switch to an available channel and slot to communicate.   

XPT IP Multi-site Interconnect Trunking System connects multiple XPT Single-site systems via IP 

network to build an IP interconnect digital repeating system. This Multi-site system not only can ensure 

the channel resource sharing of XPT single-site system, but also can extend the communication 

coverage of XPT system. (Note: XPT IP Multi-site Interconnect Trunking System will be available in later 

version. Please refer to Feature List released by Hytera for more information) 

XPT system can directly upgrade the software modules of radios and repeaters on the basis of the 

current digital conventional system. In such case, the enterprises can extend the communication 

capacity in existing system without purchasing plenty of extra equipments, which can greatly reduce the 

upgrade cost. Moreover, XPT system also supports the digital functions of conventional system. It can 

provide high capacity, large coverage, affordable and cost-efficient digital trunking solution by using 

entry level multi-site digital repeater configuration.  
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1.5 Restriction 

 XPT system is only supported by RD98XS series repeaters of the Company.  

 XPT system is only supported by PD6 and above series, MD6 and above series, X1 series radios of 

the Company. For detailed models, please refer to 3.1.1 Radio Devices.  

 Each frequency in XPT system should satisfy certain conditions. If the frequency configuration is 

inappropriate, the generated intermodulation component will interfere with the operation of the 

system. Please see Frequency Configuration Requirement in 5.1 System Planning for details.  

1.6 Version 

 The XPT system is supported in repeaters and radios with firmware version of R7.0 and above. 

Please upgrade the firmware version of repeaters and radios to R7.0 and above for proper operation.  
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2. Application Scenario 
Currently, XPT system is mainly used in the following scenarios:  

2.1 A System with Hytera RDAC 

Home Repeater (G1/G2/G3)

Home Repeater (G4/G5)

Home Repeater (G6/G7/G8)

Free Repeater

R1

R2

R3

Radio1

Radio2

Radio3

Switch

Local RDAC

…

 
Figure 2–1 A System with Hytera RDAC 

One of the repeaters has an additional role of Master; a broker for discovering repeaters. The Master 

has a static address (i.e. IPv4 address and UDP port number), which is configured in all the repeaters 

and RDAC. Static address is an address that does not change with time. If the address of the Master 

changes, then all the repeaters and RDAC must be reconfigured with the new address.  
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2.2 A System with Dispatcher of Mobile Radio 

Home Repeater (G1/G2/G3)

Home Repeater (G4/G5)

Home Repeater (G6/G7/G8)

Free Repeater

R1

R2

R3

Radio1

Radio2

Radio3

Switch
Application 

Server

…

Mobile 
(Dispatcher)

 

Figure 2–2 A System with Dispatcher of Mobile Radio 

 Support services：Radio Registration Service (RRS), GPS, Radio Call Control (CC), Telemetry, Text 

Message (TMS), Data Transfer, Work Order, Over the Air Programming (OTAP), Radio Control 

(RC), Supplementary Control 

 Only support mobile dispatcher on the first release version 

 Use shared voice channel to transmit normal GPS while no data revert channel on the first release 

version 

 

Note: Only supported two Mobile radios as dispatcher in current XPT system. 
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3. Application Conditions 

3.1 Device Requirements 

3.1.1 Radio Devices 

Radio 

Radios are used as calling and called terminals in XPT system. Currently, the supported DMR radios 

and PDT radios of the Company are listed in the table below. Here takes DMR PD78X as example for 

illustration.  

Supported 
Radio 

VHF 
(136-174MHz) 

UHF1 
(400-470MHz) 

UHF2 
(450-520MHz) 

UHF3 
(350-400MHz) 

Um 
(400-527MHz) 

PD60X √ √ √ × √ 
PD66X √ √ √ × √ 
PD68X (G) √ √ √ × √ 
PD70X (G) √ √ √ √ × 
PD70X L √ √ √ √ × 
PD70X CQST 

IIB 
√ √ × √ × 

PD70X UL913 √ √ √ × × 

PD71XEx √ √ × × × 

PD75X L √ √ √ × × 
PD78X (G) √ √ √ √ × 
PD78X L √ √ √ √ × 
PD78XC (L) √ √ × √ × 
PD78X CQST 

IIB 
√ √ × √ × 

PD79XEx IIC √ √ √ √ × 
PD79XIS ia × √ × × × 
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Supported 
Radio 

VHF 
(136-174MHz) 

UHF1 
(400-470MHz) 

UHF2 
(450-520MHz) 

UHF3 
(350-400MHz) 

Um 
(400-527MHz) 

PD78X UL913 √ √ √ × × 

X1e √ √ √ √ × 

X1p √ √ √ √ × 

X1p UL913 √ √ √ × × 

MD65X √ √ √ × × 

MD78X (G) √ √ √ √ × 

MD78X 1W √ × × × × 

 

Repeater 

Repeater is core device in XPT system, which is mainly used to repeat the TX and RX requests of the 

radio. Currently, only RD98XS series repeaters (supported frequencies: VHF, UHF1, UHF2 and UHF3) 

of the Company are supported.  

Combiner 

In XPT site, the combiner can collect signals in different frequencies output by each XPT repeater and 

send all the signals via one antenna. In this way, fewer antennas are needed, and there is no need to 

switch between different antennas.  

In one XPT site, it is recommended to use a combiner with a frequency corresponding to the repeater. 

And the combiner, the divider and the duplexer should be used together.  

The combiner is an optional device, and it is recommended to use the combiner provided by the 

Company. Please contact your local dealer or us for more information.  

Divider 

The divider used in XPT system is the receiver divider, which can receive signals from multiple 

frequencies via one antenna at a time, and divide these signals into single frequency to allocate them to 

different XPT repeaters.  

The divider is an optional device, and it is recommended to use the divider provided by the Company. 

Please contact your local dealer or us for more information.  
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Duplexer 

Duplexer is the pilot frequency duplex radio station or diplexer, which is the main part of the repeater. 

Duplexer is used to isolate the TX and RX frequency signals to ensure that TX and RX can operate 

properly at the same time.  

The duplexer is an optional device, and it is recommended to use the duplexer provided by the Company. 

Please contact your local dealer or us for more information.  

Antenna 

Antenna is used to transmit repeater signals and receive external signals. When the repeater is 

connected to antenna feeder, two antennas are needed for connection to RX and TX connectors, the 

isolation between the antennas must be larger than 60 dB. If the duplexer is used, the RX and TX 

connectors can be connected using one antenna.  

The antenna is an optional device, and it is recommended to use the antenna provided by the Company. 

Please contact your local dealer or us for more information.  

3.1.2 Network Devices 

Switch Device 

Include Ethernet switch and optical fiber switch. Please contact the supplier for detailed information.  

Router Device 

Include firewall, NAT and router (such as CISCO 1841). Please consult the supplier for detailed 

information.  

PC or Server 

PC is mainly used for the corresponding configuration, such as XPT site information, XPT repeater CPS 

configuration, and network configuration.  

Server is mainly used by third-party software and RDAC software.  

 

3.2 Network Requirements 

3.2.1 Diagram of Device Connection 

XPT System with Hytera RDAC 

In XPT site, XPT repeaters are connected to each other via one switch, and then connected to local 
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RDAC client (PC installed with RDAC software) via switch, so as to make sure that the users can 

diagnose and control each repeater via RDAC at any time and in any place.  

 

 

 
Repeater 2

 

 

 

Repeater 1

 

Radio1

Radio 2

Switch

Network Cable

RF Cable

...

 

 
 

 
 

Combiner

Divider

Duplexer

Local RDAC

 

Figure 3–1 XPT System with Hytera RDAC 

 

XPT System with Dispatcher of Mobile Radio 

In XPT site, XPT repeaters are connected to each other via one switch, and the mobile radio is 

connected to third-party application server via USB dispatching cable. Third-party server sends the 

dispatch command to the repeater via mobile radio, and then the repeater repeats the command to the 

corresponding target radios.  

 

 

 
Repeater 2

 

 

 

Repeater 1

 

Radio1
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Switch

Netwrok Cable

RF Cable
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Combiner
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Figure 3–2 XPT System with Dispatcher of Mobile Radio 
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3.2.2 Instructions on Device Connection  

The radio and repeater transfer data to each other via air interface protocol.  

 Repeater and switch are connected to each other via Ethernet port (See Red Boxes in 3.2.1 

Diagram of Device Connection). Switch is connected to router, RDAC client and WAN via Ethernet 

port and transfers voice or data via network cable.  

 Repeater and combiner are connected to each other via TX port (See Green Boxes in 3.2.1 Diagram 

of Device Connection). Repeater and divider are connected to each other via RX port (See Orange 

Boxes in 3.2.1 Diagram of Device Connection). They both transfer voice or data via RF cable.  

 TX port of duplexer is connected to ANT port of combiner (See Green Boxes in 3.2.1 Diagram of 

Device Connection) via RF cable. RX port of duplexer is connected to RX port of divider. ANT port of 

duplexer (See Blue Boxes in 3.2.1 Diagram of Device Connection) is connected to external antenna 

via RF cable.  

 Accessory connector of mobile radio (See Light Green Boxes in 3.2.1 Diagram of Device 

Connection) is connected to USB port of third-party application server and transfers dispatching 

commands via dispatch cable. Radio Control Station IP of different mobile radios involved in 

dispatching must be unique; otherwise, the dispatch station cannot identify different mobile radios. 

CPS configuration path:  XPT Trunking -> General Setting -> Network -> Radio to PC Network -> 

Radio Control Station IP 

 Please refer to corresponding references or consult the device operators for detailed information of 

different devices.  

 

3.2.3 Instructions on Network Configuration 

 In the LAN, all the repeaters under one XPT site must be configured with the different static Ethernet 

IP, but they are in same network segment.  

 Different repeaters under the same site must be connected to the same switch. It is not 

recommended to connect this switch to other equipment outside the XPT System. 

 The switch connected to the repeaters will access the WLAN via the router.  

 Each router must be configured with the NAT port mapping to allocate an extranet port for each 

repeater. This extranet port will be bound and mapped to the Ethernet IP and the configured ports of 

the repeater (please see IP Connect Configuration in Configure XPT Network).  
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3.3 Software Requirements 

XPT Site Configuration Tool - XptAps 

XptAps is the configuration tool for XPT sites, which can improve the configuration efficiency. Users can 

configure the common XPT site information in XptAps and save it into *.xml format file, and then import 

the configuration file to each repeater and radio via CPS. In this way, XPT site information of all 

repeaters or radios in the same XPT site can be consistent. If the information is configured via CPS 

respectively, it will take more time and errors may occur. It is also hard to identify system failure via 

configuration items, such as repeated repeater index number, repeated radio ID, inconsistent frequency 

of radio and repeater.  

Note: This tool needs not be installed individually. It will be installed when CPS 7.0 and above is 

installed. 

Customer Programming Software (CPS) 

The dealer can configure the radio and repeater via Customer Programming Software (CPS).  

CPS version must be R7.0 or above. For detailed software version information, please contact device 

supplier. For better configuration, please refer to the help file of CPS for details. 

RDAC Software 

RDAC Software is the Repeater Diagnosis and Control application. This software is a PC software 

developed by the Company for repeater operation status monitoring. With this software, the parameters 

and emergency status of all registered repeaters in the system can be monitored on real-time basis. 

Moreover, operators can perform basic control and configurations on the repeaters, so as to monitor and 

maintain the repeaters. Please contact your nearest salesperson or customer service for more details on 

operation of RDAC software.  

Other Software 

For example, third-party application software. 
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4. Reference 
None. 
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5. System Planning and Parameter 
Configuration 

5.1 System Planning 

One XPT single-site system must at least include two repeaters (one master and one slave) and can 

include up to eight repeaters. Each repeater can be used as voice sharing channel (specific data 

channel will be supported in later version), and there will be 16 logic channels in total. Theoretically, up 

to 16 voice channels or data channels can be supported at the same time. Each XPT system can 

support digital communication of up to 1200 users.  

XPT system can provide different function supports for 65535 users per their actual needs, which is far 

more than conventional repeater system. In XPT system, radio ID range is 1 to 65535 (16 digits), while 

group ID range is 1 to 254 (8 digits). Group ID 255 is reserved for all calls (All Call).  

For XPT single-site system, the frequency of all repeaters must be different, but their color codes can the 

same or different. XPT system can share transmission channel with other systems. But please make 

sure that all the channels in the overlapping system have unique frequency pair and color code 

combination.  

If XPT repeaters need to be removed for upgrading or repairing, the radios need not to be configured 

again. XPT system still can operate like there is only one conventional repeater in the system. Moreover, 

there is no need to shut down the whole communication system when removing or adding a repeater in 

XPT system.  

5.1.1 Planning Channel Frequencies 

When planning the channel frequencies of XPT system, the following important aspects must be 

concerned about:  

 System Property: Is this a new system? Or there is a conventional system? 

 Frequency Requirement: Are the frequencies being used new? Or need to add frequencies?  

 Conflict Management: Are there any interference issues that need to be addressed? 

 

Frequency Configuration Requirement 

Assume that the RX frequencies for repeater Channel 1 to Channel 4 are rf1, rf2, rf3, rf4; frequency 
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spacing between RX frequencies are △rf1, △rf2, △rf3; TX frequencies are tf1, tf2, tf3, tf4; frequency 

spacing between TX frequencies are △tf1, △tf2, △tf3; Channel bandwidth is BW.  

To avoid intermodulation interference, all frequencies must satisfy the following conditions at the same 

time:  

 The difference between any two value of △rf1, △rf2, △rf3, △tf1, △tf2 and △tf3 must be larger 

than or equal to BW.  

 Among △rf1, △rf2 and △rf3, (Minimum Value) – (Difference between any two value) ≥ BW.  

 Among △tf1, △tf2 and △tf3, (Minimum Value) – (Difference between any two value) ≥ BW.  

 TX frequency must be different from RX frequency of the same channel.  

 TX frequency spacing of different channel must be different. Also, RX frequency spacing of different 

channel must be different.   

Configuration Example 

Assume that XPT system has three channels, with BW=12.5 kHz. During frequency selection, frequency 

spacing of each channel is set to increase according to bandwidth. This configuration can avoid 

intermodulation interference and complies with the design of duplexer and combiner. See the figure 

below. 

TX Frequency

tf1 tf2 tf3

△tf1=△f+
BW

△tf2=△f+
2BW

RX Frequency

△rf1=△f+
3BW

△rf2=△f+
4BW

rf1 rf2 rf3

 

Figure 5–1 Frequency Configuration Reference 

Frequency configuration procedures of the XPT system are as follows:  

1. Set frequency of Channel 1 (in UHF3): TX tf=353 MHz, RX rf=363 MHz;  

2. Set TX frequency spacing between Channel 2 and Channel 3 to frequently used frequency spacing 

△tf2=250 kHz of UHF3 combiner;  

3. Calculate the frequency fixed spacing △f=225kHz according to △tf2=△f+2BW in Step 2;  

4. Calculate other frequencies according to △tf, △rf, BW and frequency of Channel 1. The calculation 
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formula is as follows. 

Assume that N channels need to be set in XPT system, the TX frequency spacing between Channel 

(M-1) and Channel M is set to frequently used frequency spacing △tfm of combiner in certain 

frequency band.  

Then, Frequency fixed spacing △f = Combiner frequency spacing △tfm – (M-1) x BW, and  

 TX Frequency = Channel 1 TX Frequency (TX Reference Frequency) + (Channel No. - 1) x 

Combiner frequency spacing △tfm + (Channel No. - 1) x (Channel No./2 – M + 1) x BW 

 RX Frequency = Channel 1 RX Frequency (RX Reference Frequency) + (Channel No. - 1) x 

【Combiner frequency spacing △tfm + (Channel No. + 6 – 2M)/2 x BW】 

 

According to the calculation formula, the calculation results of Channel 2 and Channel 3 are listed in the 

table below.  

Channel No. TX tf (MHz) RX rf (MHz) 
Frequency Spacing with 
Previous Channel (MHz) 

Channel 1 353 363 / 

Channel 2 353.2375 363.2625 

TX frequency spacing △

tf=0.2375 

RX frequency spacing △

rf=0.2625 

Channel 3 353.4875 363.5375 

TX frequency spacing △

tf=0.25 

RX frequency spacing △

rf=0.275 

 

5.1.2 Loading Considerations 

When planning the load balancing of XPT system, the following important aspects must be considered:  

 How many users will be on the system? 

 Will the system add new users in the future? System planners should design the system to 

accommodate future users that may be added. 

 It is possible that more channels may need to be added if a great lot of subscribers are added. 



System Planning and Parameter Configuration XPT Sysem_Application Notes 

 

20 

 XPT system ideally can support 100 subscribers per slot 

 If attempting to put 300 subscribers on a 2 slot voice system and the system will be busy often 

 Adding more data radios or shortening the GPS update period could also drive the need for more 

revert slots on the system. 

 

5.1.3 Future Considerations 

When planning the XPT system, the expansibility of the system must be considered:  

 What's the maximum number of users the system can support? 

 The number of users and talk patterns should drive the amount of voice slots required. 

 High traffic patterns will require more channels in the system to ensure a good QoS (Quality of 

Service) 

 Will the system add new channels, talk groups in the future? Applies to voice and data revert 

channels. 

 It is important to note that all subscribers will need to be reprogrammed if new channels or TGs are 

added in the future. 

5.1.4 Programming methodology 

Please Plan the system in advance, then Programmers need to follow the same logic as programming a 

conventional system:  

1. What are / how many voice channels do I need to program? 

2. What are the Talk groups that I need to program? 

3. What TalkGroups do I need to hear on my radio? 

4. Will I be using a data application?  

5. If using data revert, what are the channels? 

6. Do I need more than 1 zone?  

 Do I need to access an IP Site Connect system 

 Do I need to access a other systems (such as PSTN/PABX system, Dispatch system) 
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5.2 Fail Soft Mode 

XPT system is a distributed trunking system. It has no controlling center, thus the system can tolerate 

certain failure. XPT system can automatically detect most of the failures, such as abnormality auto 

detection, physical connection break-up, network card looseness, network off-line and switch 

abnormality. XPT system will deal with different failures according to actual situation to weakening the 

adverse impacts, so as to ensure that the repeater can still work when it is in Fail Soft Mode. When the 

abnormal problem is solved, the repeater will exit Fail Soft Mode and support XPT services again.  

 When the master repeater and slave repeater malfunction:  

 The XPT repeater will enter Fail Soft Mode and broadcast corresponding beacon signal 

periodically. After then, the repeater will become a trunking system which only supports two 

trunking channels like pseudo trunking mode of conventional system, and only supports basic 

digital conventional functions.  

 The repeater in Fail Soft Mode cannot be assigned as free repeater of XPT system.  

 Radios staying on the repeater will start hunting automatically after receiving the beacon signal, 

and switch to home repeater or free repeater for monitoring.  

 When switch malfunctions:  

 The repeaters in XPT site cannot be connected to each other. The XPT single-site system will 

enter Fail Soft Mode, and each repeater will become a trunking system which only supports two 

trunking channels.  

 Logic channels in XPT single-site system will be reduced significantly. Radios on different 

channels cannot communicate with each other.  

 Radios will stay on their own home repeater and transmit and receive services in free slot of home 

repeater.  

 

5.3 Example: Simple System Design 

We will suggest a good example case that can be learnt from.  

The XPT contacts information as follows:  

Talk Group Name Talk Group ID Users Activity Applications 

XPT Group A 100 60 High NO 
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Talk Group Name Talk Group ID Users Activity Applications 

XPT Group B 110 20 Low NO 

XPT Group C 120 25 Low NO 

XPT Group D 130 20 Low NO 

XPT Group E 140 40 High NO 

XPT Group F 150 25 Low NO 

XPT Group G 160 50 High NO 

 

 This system will have 240 users and 7 talk groups. 

 In the following example we will program 3 voice repeaters (6 voice slots). 

 Assign Group A, B to be homed to repeater 1, Group C, D, E to be homed to repeater 2, and Group F, 

G to be homed to repeater 3. 

 

The XPT repeaters information as follows: 

Rpt. Name Radio ID Rpt. Type Home Group Power Level TX/RX Freq. 

Repeater1 100 Voice (Master) A, B, High 353 / 363 (CH X1) 

Repeater2 101 Voice (Slave) C, D, E, High 
353.2375 / 363.2625 

(CH X2) 

Repeater3 102 Voice (Slave) F, G  Low 
353.4875 / 363.5375 

(CH X3) 

 

5.3.1 XPT Site Configuration 

XPT site information configuration tool XptAps can ensure that site information of all the radios and 

repeaters in XPT system will be consistent, and can improve configuration efficiency magnificently.  

XPT site parameters mainly consist of Site Common Parameters and Key Parameters of Individual 

Repeater.  

To configure XPT site parameters in XptAps, do as follow:  
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Step 1 Run XptAps tool in any of the following ways:  

 Start menu. Path: Hytera RCPs -> Customer Programming Software -> XptAps;  

 CPS installation directory. Default directory: C:\Program Files\Hytera\Customer 

Programming Software\XptAps.exe 

 

Figure 5–2 XPT Site Config Tool Main Interface 

 

Step 2 Click “site” to configure common parameters of XPT site.  
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Figure 5–3 XPT Site Common Parameter Configuration Interface  

Parameters Description Setting 

Alias Alias of the site.  

Range: A string 

consisting of 1-16 

characters.  

Freq Range 
Frequency range for each repeater in the site. After then, 

frequency of each repeater must be set within this range.  

Select from the drop 

down list.  

U3 frequency band is 

selected in example.  

OperationMode 

There are two modes for repeater: Conventional Repeater 

and XPT Repeater. The repeater can only operate in one 

mode for each time.  

Read-only and XPT 

Repeater only 

Site ID ID for current XPT site.  Range: 1-30 

Interference 

Detection 

If you enable Interference Detection, when the carrier 

RSSI of repeater no less than the value of RSSI Threshold 

parameter, the repeater cannot transmit on current 

To enable this 

feature, select 

Enable. 
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Parameters Description Setting 

RSSI 

Threshold 

channel. Then the repeater will broadcast subscribers to 

monitor other repeater. 

We need to make sure the Interference Detection and 

RSSI Threshold of all repeaters in XPT system are same. 

Range: -130 to 

-40dBm 

Default: -100dBm 

Power Level 

TX power of repeater under the site.  

 High: High power can extend the signal coverage, 

enabling you to communicate with farther radios.  

 Low: Generally, we recommend you to adopt low power 

for battery saving. However, if you cannot 

communicate with radios located at a distant place 

with low power, please select high power.  

Please select 

according to actual 

conditions.  

Default: Low 

Beacon 

Idle repeater will broadcast beacon signals periodically. Radio can find the repeater according to the 

beacon signals and detect the signal strength of the repeater.  

If the XPT Network is LAN, we need to make sure the Beacon Duration and Beacon Interval of all 

repeaters and subscribers in XPT system are same. 

Interval 
Sets the interval time for repeater beacon signal 

transmission.  

Sets according to 

actual conditions.  

Range: 960-18000 

ms 

Default: 2160 ms 

Duration 

Sets the duration for repeater beacon signal transmission.  

It is recommended to configure proper duration according 

to the repeater numbers in the site. See the table below.  

Repeater numbers in Site Recommended Beacon Duration 

 1-3                         ≥240 ms 

 4-6                         ≥360 ms 

 7-8                         ≥480 ms 

Sets according to 

actual conditions.  

Range: 240-1800 ms 

Default: 480 ms 

Table 5–1 Configuration Descriptions on XPT Site Common Parameter 
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Step 3 Select the repeater under the site to configure the key information of master repeater and slave 

repeater.  

 Please add or delete the repeaters according to actual situations. In planning example, we 

need three repeaters, thus CH X4 will be deleted.  

There is four repeater under one site by default. To add a repeater, select the site alias (Site 

by default) and right click to select “Add Repeater”; to delete a repeater, select the repeater 

alias and right click to select “Delete Repeater”.  

          

 Sets key information of repeaters. In planning example, we need one master repeater (CH 

X1) and two slave repeaters (CH X2 and CH X3).  

Under one site, there must be at least two repeaters (one master repeater and one slave 

repeater). Each site can include up to eight repeaters, but can only have one master 

repeater.  

      

Figure 5–4 Master Repeater Parameter Configuration Interface-CH X1 
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Figure 5–5 Slave Repeater Parameter Configuration Interface-CH X2 

      

Figure 5–6 Slave Repeater Parameter Configuration Interface-CH X3 

Parameters Description Setting 

Basic 
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Parameters Description Setting 

Repeater Type 

 Master: One repeater must be assigned as 
Master Repeater in each site. It is used to 
manage other repeaters in the same site and 
configure the Home Group for each repeater.  

 Slave: Repeaters except for Master Repeater 
are slave repeaters. Slave repeaters are 
connected to the Master Repeater to build the 
XPT site.  

Sets according to actual 

conditions.  

In planning example, CH X1 

is Master Repeater while CH 

X2 and CH X3 are Slave 

Repeaters.  

Channel 

Configure the default channel CH X1 of the repeater. After importing the configuration into CPS, write 

the configuration to CH X1, CH X2 and CH X3.  

Channel Alias Alias of the channel.  
Range: A string consisting of 

1-16 characters.  

Color Code 

Color code can indicate a system. Different 

repeaters in the same site can be set with different 

color codes, but repeaters and radios with the 

same frequency in the same site must be set with 

the same color code; otherwise, they cannot 

communicate with each other.  

Range: 0-15 

Default: 1 

RxFreq(MHz) Sets RX frequency of the channel.  In planning example, TX 

frequency of Master 

Repeater (CH X1) is 353 

MHz, while RX frequency is 

363 MHz. 

TxFreq(MHz) 

Sets TX frequency of the channel.  

Note: The RX Frequency and TX Frequency for 

different repeaters must be set different in one XPT 

site. 

Xpt Service 

Repeater Index 

The unique identification number of repeater in the 

site.  

In a single site, index number of each repeater 

must be unique and is consecutive number starting 

from 1.  

Read-only. The index number 

of each repeater is assigned 

by the tool automatically. You 

can view it but cannot change 

it.  

Range: 1-8 
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Parameters Description Setting 

CapacityInSite 

The number of repeaters of the current site. This 

parameter will be available only when Repeater 

Type is set to Master.  

Read-only. The capacity is 

configured according to the 

current site by the tool 

automatically. The number of 

repeaters of the current site 

will be displayed.  

Range: 1-8 

HomeGroup 

Sets the Home Group for each repeater under the current site. Home Group for different repeaters 

must be unique. This parameter will be available only when Repeater Type is set to Master.  

Repeater Index 
The unique identification number of repeater in the 

site.  
Range: 1-CapacityInSite 

GroupID 
Sets the Home Group ID of the repeaters. One 

repeater can be set with up to 30 Home Group IDs.  
Range: 1-240 

Table 5–2 Configuration Descriptions on Repeater Parameters 

Note: The configurations are different for Master Repeater and Slave Repeater. See orange 

boxes in Figure 5–4 and Figure 5–5 for details.  

 

Step 4 Save the XPT site parameter configurations.  

After finishing XPT information configuration, you can export and save the configuration into 

files (.xml format by default) by clicking “Export” button. Also, you can import the existing 

configuration file by clicking “Import“ button to view and modify the configurations.  

Note: “Import” and “Export” buttons are available only in Common interface. Click site alias on left 

screen to open Common interface.  
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Figure 5–7 Exporting XPT Site Configuration 

 

5.3.2 Repeater Configuration Guidance 

After configuring the site parameters via XPT tool, you need to configure other parameters of repeaters 

and radios via CPS respectively.  

Caution:  

 When the configuration file import successfully, name of the parameter which has been 

configured in file will turn blue in CPS please see Figure 5–11.  

 If the parameters in CPS was configured by “XPT Site Config Tool”， you need not to set again, 

and we suggest strongly that do not modify in CPS. 

Import XPT Site Configuration 

Import the site information and repeater information configured via XPT tool into repeater CPS.  

Step 1 Read the repeater to be configured.  

 

Step 2 Set the repeater index.  
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CPS will import the corresponding repeater configuration according to the repeater index. For 

example, the index number of the repeater is 3, and CPS will import repeater configuration of 

Repeater Index 3 from the configuration file. The default index is 1.  

CPS path: XPT Trunking -> XPT Service -> Setting -> Site Setting -> Repeater Index 

 

Figure 5–8 Set the repeater index 

Caution: XPT trunking functions need to be authorized by acquiring License. After being authorized, 

if the XPT trunking menu is not displayed in CPS, go to “Common -> Feature Control” to enable XPT 

Trunking, and then go to “Common -> Setting -> Basic” to set Repeater Operation Mode to XPT 

Repeater. See below:  
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Step 3 Import XPT setting file. 

CPS path: Tools -> Import XPT setting -> Select File -> Import 
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Figure 5–9 Import XPT Setting Interface 

 

Figure 5–10 Selecting and Importing Configuration File 

 

Set Operation Mode 

Sets Repeater Operation Mode to XPT Repeater. Currently, conventional repeaters are not supported 

by XPT system.  

Path: Common -> Setting -> Basic -> Repeater Operation Mode. See Figure 5–11. 

Parameters: Repeater Operation Mode 

Description: The repeater can operate in XPT Repeater mode only in XPT system. 
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Figure 5–11 Set Repeater Operation Mode 

 

Configure XPT Network 

 Basic Setting of Network 

Path: XPT Trunking -> General Setting -> Network -> Basc Setting. See Figure 5–12. 

Parameters: All parameters in Figure 5–12.  

Description: Refer Table 5–3 to for parameter descriptions.  

 
Figure 5–12 Basic Setting of Network 

Parameters Description Setting 

Ethernet IP 

This parameter is used to set the Ethernet IP for the 

repeater.  

The Ethernet IP for each repeater of all XPT sites in 

LAN Network must be fixed and unique. 

So please uncheck the “DHCP”. 

Method：Manual input 

Range: 0.0.0.0 - 

255.255.255.255 



XPT Sysem_Application Notes System Planning and Parameter Configuration 

 

35 

Parameters Description Setting 

Gateway IP 
This parameter is used to set the gateway IP under 

TCP/IP protocol for the repeater or transceiver.  

Netmask 
This parameter is used to set the subnet mask for 

the repeater or transceiver.  

Table 5–3 Configuration Descriptions on Basic Setting of Network 

 IP Connect Configuration of Network 

Path: XPT Trunking -> General Setting -> Network -> IP Connect Configuration. See Figure 5–13 

and Figure 5–14. 

Parameters: See orange boxes in Figure 5–13 for master repeater configurations; See orange 

boxes in Figure 5–14 for slave repeater configurations. 

Description: Refer to Table 5–4 for descriptions on key paratemers of IP Connect Configuration. For 

other related paramters, please refer to CPS Help. 

 
Figure 5–13 IP Connect Configuration of Network-Mater Repeater 
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Figure 5–14 IP Connect Configuration of Network-Slave Repeater 

Parameters Description Setting 

Repeater 

Type 

This parameter allows the user to configure the 

operation mode of the repeater. 

 Mater: The repeater serves as the master of the 
XPT system and manages other repeaters in the 
same site. Only one master is allowed in one site.  

 Slave: The repeater serves as the slave and 
connects to the master to build up the XPT system. 
Multiple slave repeaters are allowed in one site. 

Method: Select from the 

drop down list.  

Master IP 

This parameter is used to specify the IP Address of the 

master in the IP Multi-site Connect system.  

Enter the IP Address of the master in the XPT site. 

Method: Manual input 

Range: 0.0.0.0 - 

255.255.255.255 

Note: This parameter is 

only for Slave repeater. 

Master UDP 

Port 

This feature allows the user to specify the User 

Datagram Protocol (UDP) port number of the master 

repeater within the IP network. UDP is a protocol used 

for peer-to-peer services within the IP network. 

Method: Manual input 

Range: 1024 – 65535 

Note: The Master UDP 
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Parameters Description Setting 

IP Connect 

Networking 

UDP Port 

This port is used to establish and maintain the network 

connection between repeaters connected to each other 

via IP address. 

This port must be different from Remote RDAC UDP 

Port parameter. 

Port parameter is only for 

Slave repeater. 

Caution：The IP Connect 

Networking UDP Port 

must be same form Master 

UDP Port parameter and 

The two parameters of all 

repeaters in XPT System 

must be same. 

Remote 

RDAC 

This option allows the user to enable Remote RDAC 

(Repeater Diagnostic and Control) function.  

If the XPT system connects with the Hytera RDAC, 

please check Remote RDAC and set UDP Port. 

Method: Check 

Remote 

RDAC UDP 

Port 

This option allows the user to configure the UDP port 

used for Remote RDAC function.  

This port must be different from IP Connect 

Networking UDP Port parameter.  

Method: Manual input 

Range: 1024 - 65535 

Table 5–4 Configuration Descriptions on IP Connect Configuration of Network 

 

 Other Network parameters 

Path: XPT Trunking -> General Setting -> Network -> Remote Upgrade Service，and XPT Trunking 

-> General Setting -> Network -> SNMP. See Figure 5–15 

Parameters: All parameters in Figure 5–15 

Description: Please refer to the CPS help file for related parameter descriptions. 

 If enable the Remote Upgrade feature, the repeater to be upgraded will be connected to the IP 

Network and upgraded remotely via the tools. 

 SNMP feature allows setting the IP address for third party application which supports SNMP, so 

as to establish a connection between the third party application and the repeater. 
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Figure 5–15 Other Network parameters 

 

Configure XPT Service 

 XPT Site Parameters 

Path: XPT Trunking -> XPT Service -> Setting. See Figure 5–16. 

Parameters: See orange boxes in Figure 5–16. 

Description: For key parameters description of Site Setting module, please see Table 5–1 and Table 

5–2, or refer to CPS Help. It is recommended not to modify, but can configure via XPT tool. For key 

parameters description of Authentication module, please see Table 5–5.  

Note: The Repeater Capacity in Site is the number of XPT repeaters in one XPT site. And this 

parameter is only for Master repeater. 
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Figure 5–16 XPT Site Setting Parameters 

Parameters Description Setting 

Authentication 

This parameter allows you to enable or disable the 

Authentication feature to prevent illegal radio into XPT 

system. If the XPT system requires authentication 

between the repeater and radio, all the repeaters and 

subscribers will need to be enabled with this feature 

and be set with the same Authentication Key in XPT 

system are same. 

Method: Check 

Authentication 

Key 

This parameter allows you to set the Authentication 

Key used in XPT authentication.  

Method: Manual input 

Range: A string of 32 hex 

characters, each character 

can be 0 to F. 

Table 5–5 Configuration Descriptions on XPT Authentication Parameters 

 Home Group List 

Path: XPT Trunking -> XPT Service -> Home Group List. See Figure 5–17. 

Parameters: See orange boxes in Figure 5–17. 

  Description: See HomeGroup in Table 5–2, or refer to CPS Help. The Home Goup ID List is only 
for Master repeater and if you want to modify, please use the XptAps tool. 
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Figure 5–17 Home Group List  

 

Configure XPT Channel 

XPT channel is the operating frequency of XPT repeater. One repeater can only operate on one channel 

at a time.  

 Configure XPT Master repeater channel 

Path: XPT Trunking -> Channel -> XPT Channel, See Figure 5–18. 

Parameters: All parameters in Figure 5–18. 

Description: Refer to corresponding parameters in  Table 5–2, or refer to CPS Help. 

 

Figure 5–18 XPT Channel Configuration Interface 

 

 Configure Slave repeaters channels 
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Change the repeater index and import XPT setting files to configuration Repeater 2 (CH X2) and 

Repeater 3 (CH X2). 

 

 

 

5.3.3 Subscriber Configuration Guidance 

Caution: 

 When the configuration file import successfully, name of the parameter which has been 

configured in file will turn blue in CPS please see Figure 5–21.  

 If the parameters in CPS was configured by “XPT Site Config Tool”， you need not to set again, 

and we suggest strongly that do not modify in CPS. 

 

Import XPT Site Configuration 

Import the site configuration configured via XPT tool into radio CPS.  

Step 1 Read the radio to be configured.  

 

Step 2 Import XPT setting file. 
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CPS path: Tools -> Import XPT setting -> Select File -> Import 

 

Figure 5–19 Import XPT Setting Interface 

 

Figure 5–20 Selecting and Importing Configuration File 

 

Configure XPT Contact 

Configure the contacts whom do you want to be able to talk to or which Talk Groups do you need access 

to. 

Path: XPT Trunking -> XPT Service -> Contact -> Contact List. See Figure 5–21. 

Parameters: Parameters in Contact List module in Figure 5–21. We need add XPT private call (call ID 

from 1 to 240) and the XPT group call、Group A (100)、Group B (110)、Group C(120)、Group D (130)、

Group E (140)、Group F (150)、Group G (160) 

Description: Please refer to the CPS help file for related parameter descriptions. 

Caution: The XPT group of Group ID List is configured in XPT Site Config Tool. If the group that 
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you add in left table (Contact List) is not in the Group ID List, the subscriber cannot call the XPT group. 

 
Figure 5–21 XPT Contact Configuration Interface 

 

Configure XPT RX Group 

Configure the RX Group which Talk groups do you need to hear. RX Group List feature is helpful to 

receive more than one group call on a XPT site. 

Path: XPT Trunking -> XPT Service -> RX Group -> Group List N. See Figure 5–22. 

Parameters: All parameters in Figure 5–22. 

Description: Please refer to the CPS help file for related parameter descriptions. 

 

Figure 5–22 XPT RX Group List Configuration Interface 
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Configure XPT System Channels 

Sets all available frequencies supported by the radio in XPT system.  

Path: XPT Trunking -> XPT Service -> System Channels -> Repeater Frequency List. See Figure 5–23. 

Parameters: All parameters in Figure 5–23. The system channels are configured in “XPT Site Config 

Tool”: the “CH X1” is the frequency information of repeater1 of “XPT Site Config Tool”, the “CH X2” is for 

the repeater2, the “CH X3” is for the repeater3. 

Description: Repeaters and radios with the same frequency in the same site must be set with the same 

color code; otherwise, they cannot communicate with each other. Please refer to the CPS help file for 

related parameter descriptions. 

 
Figure 5–23 XPT System Repeater Frequency List Configuration Interface 

 

Configure XPT Site Channel List 

To add XPT Site Channels in order. 

Path: XPT Trunking -> XPT Service -> Site Channel List. See Figure 5–24. 

Parameters: All parameters in Figure 5–24. 

Description: Please refer to the CPS help file for related parameter descriptions. 
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Figure 5–24 XPT Channel List Configuration Interface 

 

XPT Common Setting 

Configure the common parameters of XPT site. 

Path: XPT Trunking -> XPT Service -> Setting. See Figure 5–25. 

Parameters: All parameters in Figure 5–25. 

Description: Please refer to the CPS help file for related parameter descriptions. We need to make sure 

the Authentication and Authentication Key of all repeaters and subscribers in XPT system are same. 

 

Figure 5–25 XPT Common Parameter Configuration Interface  

 

Configure XPT Emergency 

Emergency is used to summon help in emergency situations. When an Emergency system is associated 

to a personality, the radio user can activate emergency through the programmed key. 

Path: XPT Trunking -> Emergency -> XPT Emergency. See Figure 5–26. 
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Parameters: All parameters in Figure 5–26. 

Description: Please refer to the CPS help file for related parameter descriptions. 

Note：The difference between XPT Emergency system and Digital Emergency system as follow:  

 For XPT Emergency, there is no need Emergency Revert Channel. 

 For XPT Emergency, we need to configure Emergency Contact, and this contact is configured in 

“XPT Trunking -> XPT Service -> Contact -> Contact List” , please see Configure XPT Contact in 

5.3.3 Subscriber Configuration Guidance. 

 When there is no emergence contact, the Emergency Mode is read-only.  

 

Figure 5–26 XPT Emergency Parameter Configuration Interface  

 

Configure XPT Personality 

XPT Personality defines the common attributes of multiple channels by setting the attributes of the 

Channel List. One channel list is related to one site under XPT system, thus one personality is related to 

one XPT site. Unlike conventional series radios, the radios in XPT trunking system switch the personality 

(XPT site) instead of channel via the Channel Selector Knob. XPT trunking system has a larger 

capacity than conventional system. 

Path: XPT Trunking -> Channel -> XPT Personality. See Figure 5–27. 

Parameters: All parameters in Figure 5–27. 

Description: Please refer to Table 5–6 for key parameters of XPT Personality and refer to the CPS 

help file for other parameter descriptions. Also, you can add multiple personalities in this interface per 

actual needs.  
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Figure 5–27 XPT Personality Parameter Configuration Interface  

 

Parameters Description Setting 

Home Channel 

This parameter allows you to set a home channel for 

the channel list, which is corresponding to the home 

repeater. The radio will transmit in the home channel 

first. 

The options in the drop down list are set in System 

Channel (please see Configure XPT System 

Channels in 5.3.3 Subscriber Configuration 

Guidance). 

Method: Select from the 

drop down list. In the 

example, the home 

channel for each radio is 

CH X1 (Repeater 1).  

TX Admit 

This parameter allows you to control the transmission 

when there are ongoing activities on the channel. 

 Channel Free: The radio is allowed to transmit 
when the channel is free.  

 Code Color Free: The radio can transmit only 
when the channel is free or the color code is not 
matched. 

Method: Select from the 

drop down list.  
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Parameters Description Setting 

TX Contacts 

Name 

This parameter allows you to set a regular contact for 

the XPT site. The radio sends a call to this contact if 

the radio user holds down the PTT key in standby 

mode. However, after a group call is received, holding 

down the PTT key within the Group Call Hang Time 

can talk back to the group, but not initiate a new call. 

If the selected TX Contacts Name is a group call 

contact, it must be a contact set in Home Group List 

of its home repeaters. 

Method: Select from the 

drop down list. 

Note: The TX Contacts 

Name is from contact list 

(please see Configure 

XPT Contact in 5.3.3 

Subscriber Configuration 

Guidance) 

RX Group List 

This parameter allows you to associate a RX Group 

List with the current XPT site. In presence of any 

activity that match the talkgroup ID in the RX Group 

List , the radio unmutes and allows radio user to 

respond and talkback within the defined Group Call 

Hang Time. 

Method: Method: Select 

from the drop down list. 

Note: The RX Group List 

is from RX Group, please 

see Configure XPT RX 

Group in 5.3.3 Subscriber 

Configuration Guidance. 

Emergency 

System 

This parameter allows you to associate a XPT 

emergency system to the current XPT site. 

The Emergency System is from XPT Emergency, 

please see Configure XPT Emergency in 5.3.3 

Subscriber Configuration Guidance. 

Method: Method: Select 

from the drop down list. 

Beacon Interval 
The Beacon Interval of the subscriber must be same 

as the repeater in one XPT site.   

Method: Manual input 

Note: Not recommended 

to modify. 

Table 5–6 Configuration Descriptions on XPT Personality Key Parameters 

 

Add XPT Personality to Zone 

The zone allows users to organize XPT personality conveniently, and each zone can support up to 16 

personalities.  

Path: XPT Trunking -> Zone. See Figure 5–28. 
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Parameters: All parameters in Figure 5–28. 

Description: All XPT personalities of the radio must be added to a certain zone; otherwise, the radio 

cannot use the personalities. Please refer to the CPS help file for related parameter descriptions.  

 
Figure 5–28 Adding XPT Personality into Zone 
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6. FAQ 
Q: In XPT mode, the network icon of the slave repeater is displayed as . The connected 

repeater is 0 when viewing from “Network -> Port Information” menu.  

A: When this icon appears, it indicates abnormal network connection of the repeater. The 

repeater cannot make connection to the control center (Master Repeater). Possible reasons are 

as follows:  

 Repeater IP Address and UDP Port of master repeater is configured improperly for slave 

repeater.  

 “Network Authentication Code” of the slave repeater is inconsistent with that of the master 

repeater.  

 Other repeater in XPT system has configured with a same index number with the slave repeater.  

 

Q: When the calling radio initiates a call, the called radio always joins the call with delay.  

A: Possible reasons are as follows:  

 TX or RX antenna of the repeater is attached improperly.  

 Master UDP Port of slave repeater is different from IP Connect Networking UDP Port, causing the 

slave repeater fail to receive network status updating message from other repeaters.  

 Beacon Interval of the radio is different with that of the repeater.  

 Network connection of the repeater is abnormal.  

 When initiating a group call, if the target group exists in the Home Group List of the master 

repeater, also it is the home group of the repeating repeater, then Late Entry is a normal situation.  

 

Q: When initiating a call, the radio displays Authentication Failure.  

A: Radio or repeater has not enable the Authentication feature, or radio and repeater have 

configured with different authentication codes.  

 

Q: When initiating a call, the radio displays no available channels for the moment.  

A: Possible reasons are as follows:  

 The frequencies of repeater and radio do not match.  
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 Abnormal network connection or incorrect network connection number of the repeater.  

 TX or RX antenna of the repeater is attached improperly.  

 There is no free repeater in the current system, or there is no available channel after searching for 

all the channels.  

 

Q: Radio fails to initiate a group call, displaying the called party cannot be reached.  

A: Target group ID is not configured in the Home Group List of master repeater in XPT system. 

 

Q: When initiating a call, the radio displays the call is rejected by the system.  

A: Possible reasons are as follows:  

 The system is performing an all call.  

 The system has just ended an all call, and the repeating repeater of radio call is disconnected 

from network or is powered off. In such situation, the system will return to normal after about 140 

seconds. 

 

Q: During private call or group call, the radio is interrupted and receives an all call.  

A: It is a normal situation. XPT system has enabled the Priority Call feature, the radio will receive 

call with higher priority first. Currently, the call priority is: XPT Emergency Call > XPT All Call > 

XPT Private Call or XPT Group Call (XPT Private Call and XPT Group Call have the same priority). 

 

Q: The radio is registered successfully and the network connection number of the repeater 

monitored by the radio is normal. When the radio initiates a call, other repeaters cannot receive 

it.  

A: IP Connect Networking UDP of the current repeater is different with that of other repeaters in 

the XPT system, causing the repeaters fail to transfer information in network via broadcasting 

pack.  

 

Q: After power-on, the radio displays “Hunting, Please Wait!”.  

A: After power-on, if the radio does not receive the system broadcasting message, it will be in 

hunting status.  
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Q: When initiating a call, the radio displays abnormal configuration.  

A: The channel of the free repeater assigned by XPT system is not within the sharing channel list 

of the radio, or the member order of the sharing channel list is not consistent with that of 

operating channel of the repeater.  

 

Q: When initiating a call, the radio displays abnormal network connection.  

A: The repeater assigned to the radio by XPT system is disconnected from the network.  
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